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Thank you for purchasing the JVC VN-S400U. 
To gain maximum benefit from this product, read this 
instruction manual carefully before use and retain it for future 
reference.
The serial number is very important for maintaining quality of 
your product. At the time of purchase, check to see that the 
serial number is correctly printed on the bottom of the unit 
and that the serial numbers on the unit and warranty match.

Please read this manual before reading 
any of the other relevant materials.
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Thank you for purchasing the JVC VN-S400U Multi Viewer
Software (hereinafter referred to as VN-S400U).

This Installation Manual describes the method of installing the VN-S400U and of setting it up
for operation.

1. End-user License Agreement ..................3

2. Operating Environment............................5

3. Configuration of the CD-ROM .................5

4. Installing the Components .......................6

5. Installation of the VN-S400U ...................7

6. Activation Setup.......................................8

� List of provided accessories
Check that the following accessories are packaged together in the product carton.

● Setup CD-ROM ........................... x 1

● Installation Manual ...................... x 1

Note

The corporate names and product names mentioned in this manual are the trademarks or the
registered trademarks of the respective owners.
Marks such as ™, ©, and ® have not been described in this book.
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1. END-USER LICENSE AGREEMENT
Please carefully read this End-User License Agreement ("Agreement") before installing or using
"Multi Viewer Software[VN-S400U]"("Software") on your PC.  The right to use the Software is granted
by Victor Company of Japan, Limited ("JVC") to You only on the condition that You agree to the
following Agreement.  If You do not agree to the terms of the Agreement, you may not install the
Software.  INSTALLING OR USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE
TERMS AND CONDITIONS.  The Software also includes the associated materials, and any modi-
fication, upgrade and update of the Software granted to You by JVC.

1. Copyright; Ownership
You acknowledge that all copyrights and other intellectual property rights in the Software is
owned by JVC and its licensor, and remain vested in JVC and such licensor.  The Software is
protected under the copyright law of Japan, the United States, other countries, and related
Conventions.

2. Grant of License
(1) Subject to the conditions of the Agreement, JVC grants to You a non-exclusive right to use the

Software.  You may install and use the Software on a HDD or other storage devices incorpo-
rated in Your PC.

(2) You may make a copy of the Software for the back-up and storage purpose.

3.  Restriction
(1) You may not modify, reverse engineer, decompile or disassemble (except to the extent as

permitted by the applicable laws) the Software in any manner.
(2) You may not copy or use Software, in whole or in part, other than as expressly specified in this

Agreement.
(3) You have no right to grant a license to use the Software, and may not sell, lease or rent the

Software to any other person for any purpose.

4. Limited Warranty
THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND.  JVC MAKES
NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRAN-
TIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  SHOULD THERE
BE ANY PROBLEM ARISING FROM OR CAUSED BY THE SOFTWARE, YOU SHALL BE RE-
SPONSIBLE TO SETTLE ALL SUCH PROBLEMS AT YOUR OWN COSTS.

5. Limitation of Liability
JVC SHALL HAVE NO LIABILITY WITH RESPECT TO ITS OBLIGATIONS UNDER THIS AGREE-
MENT OR OTHERWISE FOR CONSEQUENTIAL, EXEMPLARY, INCIDENTAL OR PUNITIVE
DAMAGES EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
YOU WILL INDEMNIFY AND HOLD HARMLESS JVC FROM ANY LOSS, LIABILITY OR COSTS
ARISING OUT OF OR IN ANY WAY CONNECTED TO CLAIMS FROM ANY OTHER PERSONS
RELATING TO THE USE OF THE SOFTWARE.
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6. Term
This Agreement will become effective on the date when You install the Software onto Your
machine, and continue to be in effect until the termination under the reasons as below:
Should You breach any provision of this Agreement, JVC may terminate this Agreement with-
out giving any notice to You.  In this event, JVC may claim against You any damages caused
by Your breach.  Should this Agreement be terminated, You should immediately destroy the
Software stored in Your machine (including erasing it from any memory in Your PC), and then
will not possess such Software.
Unless You activate the Software according to JVC's instruction within the initial period of
thirty (30) days after You install, Your right to use the Software under this Agreement shall be
terminated at the end of the initial period.  However, if and when You make the activation
(notwithstanding the expiration of the initial period), You may continue to use on the same
conditions of this Agreement.

7. Export Control
You agree that You will not ship, transfer or export the Software or underlying information and
technology to any countries to which Japan and other relevant countries embargoed goods.

8. U.S. Government User
If You are an agency of the United States of America (the "Government"), You acknowledge
JVC's representation that the Software is a "Commercial Item" as defined in Federal Acquisi-
tion Regulation (FAR) part 2.101 (g) consisting of unpublished "Commercial Computer Soft-
ware" as those items are used at FAR part 12.212 and is only licensed to You with the same
use rights JVC grants all commercial end users pursuant to the terms of this Agreement.

9.  General
(1) No modification, change, addition, deletion or other alteration of or to the Agreement will be

valid unless reduced to writing and signed by an authorized representative of JVC.
(2) To the maximum extent permitted by the applicable law where the Software was acquired, any

conditions or warranties imposed or implied by law are hereby excluded.  You may neverthe-
less have the benefit of certain rights or remedies pursuant to the applicable law in respect of
which liability may not be excluded.

(3) Even if any part of the Agreement is held invalid by or in conflict with any law having jurisdic-
tion over this Agreement, the remaining provisions will remain in full force and effect.

(4) The Agreement shall be governed by and interpreted under the laws of Japan.  The Tokyo
District Court has jurisdiction over all disputes which may arise with respect to the execution,
interpretation and performance of this Agreement.
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<PC machine>
Type ........................ PC/AT compatible
CPU......................... Pentium III, 1 GHz or higher
Memory ................... 256 MB or more
Graphic board ......... DirectX support

1024 x 768 or more, True Color (32-bit recommended) or higher
*The on-board video chip may sometimes malfunction.

Sound card .............. Sound Blaster (PCI) recommended
LAN card ................. 100BASE-TX

<Compatible OS>
Windows 2000 Professional (SP4) of the English version
Windows XP Professional (SP1, SP1a) of the English version
Windows XP Home Edition (SP1, SP1a) of the English version
Note : In installation and execution of a program Administrator authority is required. To run this pro-

gram the authority of either the Administrator or the Power User is required.

<Other>
Microsoft DirectX runtime package 8.1 or higher, 9.0b recommended
Windows Media Format Runtime 7.1 or higher
Microsoft Internet Explorer 6.0 (SP1)
Windows Media Component (ISO MPEG-4, G. 726)

* The above operating environment is described only as a reference for operation and does not
guarantee its successful operation.

* To play a file (.asf or .avi) output by the VN-S400U on a PC in which the VN-S400U has not been
installed, a similar operating environment to the VN-S400U is required. (Playback of an .asf file
sometimes requires a connection to the Internet.)

[VN-S400U folder]
This folder contains the files for use in the installation of the software and the VN-S400U
User’s Guide file (VN-S400U UsersGuide.pdf).

[Acrobat Reader folder]
Executing the file in this folder starts the installation of Adobe Acrobat Reader.
Acrobat Reader is necessary for reading the VN-S400U User’s Guide.

[DirectX folder] ,  [WindowsMedia folder] and [Codec folder]
This folder contains the files for installing the components.

2. Operating Environment
The following PC environment is required to use the functions provided with
the VN-S400U.

3. Configuration of the CD-ROM
The setup CD-ROM provided with this product contains the following folders.
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4. Installing the Components
Installing the components required for playing and recording images on VN-
S400U.

� Installing DirectX

Now proceed to the installation of DirectX 9.0b.

1. Checkthe DirectX version
Click on the Windows [Start] button and then [Run]. Enter “dxdiag” and click on <OK>.
When the [DirectX Diagnostic Tool] dialog box is displayed, click the [System] tab and
check the DirectX version by referring to the [DirectX Version] . If the displayed version is
DirectX 9.0b, the next step is not necessary; click on <End> to close the dialog box and
complete the installation. If the displayed version is an older one, go to the next step.

2. Installation
Open the [DirectX] folder and the [DirectX9] folder on the setup CD-ROM, run
“dxsetup.exe” by double-clicking on its name. This starts the installation of DirectX  per-
form the installation by following the instructions displayed on the screen.

� Installing the Windows Media Format

Next, proceed to install the Windows Media Format. If you are using Windows XP (SP 1,
SP1a), you do not need to go through these procedures since Windows Media Format
7.1 or higher is already installed in your computer.
Double click on [WMFDist.exe] in the [WindowsMedia] folder in the setup CD-ROM.
Follow the instructions on the screen.

Now the components have been installed. Proceed to the installation of the VN-S400U.

� Installing Codec

Install the ISO MPEG-4 Codec.
To do this, double-click on [wmpcdcs8.exe] in the Codec folder of the setup CD-ROM
and then to follow the displayed instructions.
Next, install the G. 726 Decoder.
To do this, double-click on [JVCG726E.exe] in the Codec folder of the setup CD-ROM
and then follow the displayed instructions.
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1 Start Windows and insert the setup CD-ROM into
the CD-ROM drive.

2 Run “setup.exe” from the VN-S400U folder of the setup CD-ROM.  Click on <Next>.

3 The [License Agreement] dialog box will appear.
Read the text carefully and click on [I accept the
terms of the license agreement] if you are in
agreement with it (if not, you will not be allowed
to continue installation of the VN-S400U). Now
click on <Next>.

4 Perform the instllation by following the instruc-
tions displayed on the screen.

5 This dialog box appears when the installation is
completed normally. Click on <Finish> to exit the
wizard.

5. Installation of the VN-S400U

The VN-S400U has now been installed and it may now be started by double-clicking on the
VN-S400U icon on the desktop or by selecting Windows [Start] _ [Programs] _ [JVC] _ [VN-
S400U]. For the operation of the VN-S400U, read the User’s Guide (VN-S400U UsersGuide.pdf)
in the setup CD-ROM.

* To uninstall the VN-S400U, open the [Control Panel] and select [Add or Delete Program]
with Windows XP or [Add or Delete Application] with Windows 2000 and delete it.
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1 Open the setting screen of the [Activation] dia-
log box as follows:
Open the [Help] menu of the VN-S400U and se-
lect [Activation]. Click the “Setting” tab on the
[Activation] dialog box in order to set up the [Ac-
tivation].
Click on the [Copy] button at the right-hand side
next to the Hardware code, this will save the hard-
ware code temporarily on the clipboard.

Memo
The hardware code is generated based on the
number assigned to the network card incorpo-
rated in the PC in use (MAC address). This means
that the network card in use cannot be changed
after installation.

2 To access the dedicated website proceed as
follows:
To access the dedicated website, click on the
address (http://www.jvc-victor.co.jp/english/pro/
user/activation/vn-s400u.html) in the dialog box.
When the top page is displayed, read the “END-
USER LICENSE AGREEMENT” following the
guidance in the page and if you agree with all of
its terms and conditions click on [I AGREE]. If
not, you will not be allowed to continue with the
activation setup procedure.

6. Activation Setup
For 30 days from the first startup, the VN-S400U can be used as a trial ver-
sion. If it is required to continue use after the 30th day, set up the activation
as described in the following procedure. This will make it possible to turn the
software into an officially licensed version that can continue to be used.

The following steps 1 to 7 assume that the activation setup is performed on a
PC in which the VN-S400U is already installed. Steps 2 to 5 can also be
performed on a PC in which the VN-S400U has not been installed, by using a
storage medium such as a floppy disk or through a network. For the proce-
dure in this case, see “Acquisition of activation code from a PC in which the
VN-S400U is not installed” on page 11.
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3 Start the registration operation as follows:
When the [Obtain your activation code.] form is displayed, enter the required information.

Product Number : Enter “VN-S400U”.
Serial Number : Refer to the label on the back cover of this manual.
License Code : Refer to the label on the back cover of this manual.
Hardware Code : This is the hardware code shown in the [Activation] dialog box. Place

the cursor in the input field, right-click the mouse on it and select
[Paste]. The hardware code which has been already copied by us-
ing the [Copy] button in the [Activation] dialog box will be pasted in
this field.

After completing the entries, click on [Confirmation]
(if it is required to restart the entries from the
beginning, click on [Reset]).

When the entries are displayed, make sure that
they are correct. If it is required to change any
entry, installation location, etc., click on <Modify>
to return to the entry form.

4 Obtain the activation code as follows:
Click on [Submit this form].
The message “Your activation code is decided
and registered.” is displayed together with the
activation code.

5 Copy the displayed activation code and paste
it in the [Activation] dialog box as follows.:
Select the displayed activation code by drag-
ging it with the mouse, then right-click the mouse
and select [Copy]. This will save the applica-
tion code temporarily on the clipboard.
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6 Return to the VN-S400U [Activation] dialog box
and click on the [Setting] tab.
Click on the [Paste] button to paste the copied
activation code in the dialog box. And then click
on <Activation> to complete the activation setup
operation.
Now click on the [Information] tab and make sure
that the [Serial number] and [License code] fields
show the entered information and that the [Acti-
vation status] is [Set].

7 The activation setup is now complete.
Click on <Close> in the [Activation] dialog box.

Caution
The activation code obtained from the dedicated website should be set up (by perform-
ing the operation in step 6 above) within three months from the obtainment. If this pe-
riod has expired, access the dedicated website again and obtain another activation
code by performing the same registration operation.
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� Acquisition of activation code from a PC in which the VN-S400U is
not installed
Steps 2 to 5, beginning from page 8, can be performed on a PC in which the VN-S400U is not
installed, by using a storage medium such as a floppy disk or through a network. The proce-
dure in this case is as follows.

1. Copy the hardware code on the clipboard. (Step 1 on page 8)

2. Save the hardware code in a text file (.txt).
(Paste it in the Windows Notepad and save the text either in a floppy disk or network.)

3. Access the dedicated website, register your information and acquire your activa-
tion code. (Steps 2 to 4 on page 8 and page 9)
When registering information, open the text file saving the hardware code, and then
copy & paste the hardware code in the “Hardware Code” input field.

4. Save the acquired activation code in a floppy disk or network using either of the
methods described below.
• Open the File menu of the browser, select [Save As] and save the code in the htm

format (.htm). (e.g. when the browser in use is the Internet Explorer)
• Select the activation code, open the Edit menu of the browser or right-click the

mouse to open a menu, select [Copy], paste the copied activation code in Win-
dows Notepad and then save it as a text file (.txt).

5. In the [Activation Setting] dialog box, select the [Setting] tab, click on [Read from a
file] and select the name of the file that was created in the previous step in order to
save the activation code.

6. Click on [Set] to complete the activation setup. (Step 6 on page 10)
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License Information :

Product number : VN-S400U

Serial number :

License code :

Caution
This information is required to perform the activation setup operation in order to
enable the official use of this software. Please be sure to retain this information
carefully, as it may also be required when making an inquiry about the product.
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